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Google Web Applications

Google web applications are a set of web pages that perform certain
standard tasks, such as email, word processing and spreadsheets. These
are different from applications you download and run on your computer
since they are all done in a web browser.

Google App Type Programs That Do Similar Tasks

Gmail Email Microsoft Outlook, AOL, Yahoo Mail

Google Docs Word Processing Microsoft Word, Apple Pages,
LibraOffice

Google Sheets Spreadsheet Microsoft Excel, Apple Numbers
LibraOffice Calc

Google Calendar Calendar Microsoft Outlook
Google Contacts Contacts Apple Contacts, Microsoft Contact
Organizer

Google also makes a browser program called Chrome which must be
installed on your device (if it does not come with it). Other popular browser
programs are Safari, Firefox, Microsoft Edge and Opera.
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Google Sheets

Google Sheets is a simple and powerful spreadsheet application that has
similar features to the other spreadsheet programs. It does not have some
of their advanced features but is probably fine for most users. A
spreadsheet program is used to store rows and columns of data and
optionally do calculations on them.

It has the advantage that your documents are kept on the Cloud (Internet)
on Google computers and are associated with your Google Account. That
means that you have to sign up for a Google account to use if you don’t
already have one. It also means you can access your documents
anywhere in the world on any device that connects to the Internet. You
simply have to log into your Google account to access them.

To access Google Sheets, you can go to the Google Sheets website

https://sheets.google.com

This will redirect you to this web address:

https://docs.google.com/spreadsheets/u/0/

You can also click the Google Apps icon on Gmail which is in the upper
right part of the window and looks like a three by three square of dots:
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https://sheets.google.com
https://docs.google.com/spreadsheets/u/0/

If you use the Chrome browser, the three by three “tic tac toe” board is
colored and the first button on your Bookmark Toolbar:

N NON o Goog

=5 Apps M Gmail

When you click on one of these buttons, it will bring up a popup window
with the Google Apps:

Account Contacts Hangouts

0 ! g

Search Maps YouTube
MNews

P

Play

™M
= C

Drive Calendar Translate

2 A& M
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If scroll down, you will see the Google Sheets button:

Books Blogger Keep

B <

Classroom th Collections

2

Sheets Slides Jamboard

@ AN i

Arts and C.. Google Ads Podcasts

More from Google

This will open up Google Sheets in the current window or a new browser
tab depending on how your browser preferences are set up.

You can create lots of useful documents with this tool.
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Creating a Spreadsheet

When you first go to the Google Sheets web page, it shows you various
templates you can use to start a new document or you can create a blank
spreadsheet:

= Sheets Q, Search 32 e

A

Start a new spreadsheet Template gallery £

Tobe -
¢ b

Blank To-do list Annual budget Monthly budget

Today Owned by anyone Last opened by me H Az [

Food Log me 417 PM

ﬂ 2020 SPCO Virtual Lunch-Learn Progr... 2% SeniorPla.. 7:15AM

Below the templates are your recent spreadsheets that you have edited.
There is also a search box at the top (next to the magnifying glass) to
search for a specific document by name.

If you click on the Template gallery in the upper right part of this page, it will

show you a list of many more templates that you can use to get started with
creating your spreadsheet.
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Spreadsheet Cells, Rows, Columns

A spreadsheet is a set of data cells arranged in rows and columns.
Columns are labeled with letters (A, B, C, etc.)
Rows are labeled with numbers (1, 2, 3, etc.)
For example
D4

refers to row 4 of column D

Untitled spreadsheet
File Edit View Insert Format Data Tools Add-ons Help

o~ = P 100% v § % .0 .00 123+  Default(A.. ~

D4\

| en | s e ma | =
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Cells can contain data (numbers, text, dates) or formulas.

Formula cells have values that start with the equals character (=). If you
want to enter text that starts with the equals character, put a single quote

before the text, e.g.

‘= some text here

To select a column, click on the header (the letter above the column)

Untitled spreadsheet % &)
File Edit View Insert Format Data Tools Add-ons Help

“~ ~ g/ P O100% v § % .0 .00 123v  Default (Ari.. ~
B o D
1
this is a lot of .
, textinone cell click here
which does not
fit

O o N or n b W

Last edit ...

-

This selects all the cells in a column and they display in light blue.
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To select a row click on the row number to the left of the cells:

Untitled spreadsheet % &)
File Edit View Insert Format Data Tools Add-ons Help Lastedit..

~ ~ @ T 100% v § % .0 .00 123v Default(Ari. v 10 v ..

this is a lot of text in one cell which does not fit

click here : c D E

this is a lot of
text in one cell
which does not
fit

You can select a rectangle of adjacent cells by dragging across them:

Untitled spreadsheet ¥ &)
File Edit View Insert Format Data Tools Add-ons Help Lastedit..

“~ o~ om P 100% v § % .0 .00 123v  Default (Ar.. v 10 v

this is a lot of text in one cell which does not fit

A B c D =

1

this is a lo
2 text in o |

which does not

fit
3
; K to here
5

|

6
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Google Sheets Menu

File Menu

One of the most confusing things about using Google web applications on
a Mac is that many have a separate menu bar that is inside the browser
window. In Google Sheets, this is what it looks like:

@ safari File Edit View History Bookmarks Develop Window Help

-Io docs.google.com/spreadsheets/d/1G7TsiflaYFNEqQLPONhKDWGLZnnT N

browser menu

Untitled spreadsheet E
File Edit View Insert Format Data Tools Add-ons Help

~ P 100% ~ § % .0_ .00 123~ Default (Ari.. ~ 10 -

Google Sheets menu
. B C D E

I

n

The menu on the top of the screen is the menu for the current program (the
Safari browser in this case). The menu in the browser window under the
spreadsheet title is the Google Sheets menu. They look very similar, so
please don’t be confused by this. Notice they both have menus with names
like “File”, “Edit”, “View” and “Help”.

Probably the hardest thing to learn about using Google Sheets is that there
is a completely different menu that you use for the spreadsheet functions.

David Taenzer 10 August 2022



The File menu has many options. One that is very useful is “Download”

Untitled spreadsheet % (=
File Edit View Insert Format Data Tools Add-ons Help
e Share 6 .0_ .00 123~ Default (Ari.. ~ 10 "
New > C D E F
1 |: Open %0
2
3 Import
4 Make a copy
5
6 _
Email >
-
y Download > Microsoft Excel (.xlsx)
10 Version history " OpenDocument format (.ods)
11
PDF document (.pdf
12 Rename ] - . (-pdf)
13 Web page (.html, zipped)

Move to trash

-
.

Comma-separated values (.csv, current sheet)

-
on

Publish to the web Tab-separated values (.tsv, current sheet)

- -
-~ |

Document details

N ey
w o

Spreadsheet settings

NN
- 0

= Print ®P

w
& ]

This lets you save the spreadsheet on your computer in a variety of
different formats. The advantage of PDF files is that they look the same on
all devices and most devices are set up to view PDF files without additional

software.
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Edit Menu

The Edit menu has normal spreadsheet editing tasks like Copy, Paste, Find
and Replace.

Untitled spreadsheet ¢

Find and replace 38 +Shift+H

£ File Edit View Insert Format Data Tools
r\ A v~ Undo *Z
~ Redo aBY
A
1 | ¥ Cut $¥X
2
3 1D Copy ¥C
4 [*] Paste BV
5
6 Paste special >
,
8
!

-
o

Delete values

—
—

Delete row 1

- -
W N

Delete column A

—
=N

Delete cells and shift up

- |
oy

Delete cells and shift left

- | -
(=

Clear notes

MN =
o | w

Remove checkboxes

%]
-y

w
-

This shows the keyboard shortcuts you can use (e.g. Command / C for
copy on the Mac). This is normally Control / C on a PC.
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View Menu

The View menu lets you control what is displayed:

Untitled spreadsheet +¢
File Edit View Insert Format Data Tools Add-ons Help

"2 Freeze > No rows L.
- 1 row
A v/ Gridlines
2 rows

Protected ranges

1
2 Up to current row (4)
3
. v Formula bar
. No columns
5 Show formulas Ctrl+ -
6 1 column
7 Hidden sheets > 2 columns
= m
9 Zoom > Up to current column (A)

S Y
- D

Full screen

-
(3]

It has a Freeze option to freeze header rows so you can scroll through the
document and these rows will stay in place. You can also freeze columns if
the document is very wide.
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Insert Menu

The Insert menu has lots of useful features:

Untitled spreadsheet %
File Edit View Insert Format Data Tools Add-or
SN - ',-ﬂ Row above ult |
Row below
A
1 Column left
2
3 Column right
4
| |
5 Cells and shift down
6
; Cells and shift right
8
9 E] Chart
b Image ° >
11
12 &Y Drawing
13
Form
14 E
15
16 > Function >
17 o Insert link 8K
18
19 Checkbox
e El Comment  &+Option+M
21
22 Note Shift+F2
23
New sheet Shift+F11
+ = Sheet1
Display a menu
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You can insert extra rows and columns. You can also access this by
selecting a cell, row or column and clicking the right mouse button to see
the context sensitive menu. You can use Control / click on a Mac.

Untitled spreadsheet
File Edit View Insert Format Data 1
e K Cut EX a 12
I copy $®C
[7] Paste BV
1
2 Paste special >
3
4 Insert row
5
2 Insert column
T . Insert cells >
s right
g CIICk Delete row
10 o
1 in cell Delete column
12
Delete cells >
13
14
15 G2 Insert link #EK
16 Get link to this cell
17
18
19 Define named range
20 Protect range
21
22
— Comment
23 & +0ption+M
Insert note
+ =
Display a menu
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Format Menu

The Format menu also has lots of features.

Untitled spreadsheet %
File Edit View Insert Format Data Tools Add-ons Help
“~ ~ @ P 100%)': Theme ’

A 5 Number >
1
2 B Bold 3B
3

Z ltalic 3l
4 I
| |

5 U Underline 4
6
: 5 Strikethrough 3£ +Shift+X
8
9 Font size >
10
" Align >
12
13 Merge cells >
14 Text wrapping >
15
16 Text rotation >
17
18 Conditional formatting
19
20 Alternating colors
21
22 Y. Clear formatting a8\
23
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For example, if | type in a lot of text in a cell:

Untitled spreadsheet ¢ >
File Edit View Insert Format Data Tools Add-ons Help Lastedit..

~ o~ @ P 100% v § % .0 .00 123v Default(Ar. v 10  ~

this is a lot of text in one cell which does not fit
A B C D E

this is a lot of lex.l in one cell which does not fit
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| can use the Format / Text Wrapping / Wrap option to fix this:

Untitled spreadsheet ¢ &
File Edit View Insert Format Data Tools Add-ons Help Lastedit..
- o~ | 1001 Theme F10 v e
this is a lot of text in one cell v
A B Number > £ v
1
2 misisalotoflex.linonecellwhi B Bold 3B
3
I ltalic $l
4
5 U Underline $u
6
- 5 Strikethrough B +Shift+X
8
g Font size >
10
" Align >
12
13 Merge cells >
14 .
e / Text wrapping >  Overflow
16 Text rotation > Wrap
17 2 -
18 Conditional formatting 'P
19
20 Alternating colors
21
22 Y Clear formatting #*\
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This will wrap the text in the cell:

Untitled spreadsheet % &
File Edit View Insert Format Data Tools Add-ons Help Lastedit..

~ ~ @ T 100% v $ % 0 .00 123v Default(Ari.. v 10~

this is a lot of text in one cell which does not fit

A B o D E

1

this is a lot of
2 text in one cell

which does not

fit

| |

3

Any of the formatting options can be applied to a cell, row(s), column(s) or
a rectangle of cells.
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Data Menu

The Data menu has a number of useful functions:

this is a lot of
text in one cell
which does not
fit

O 0 N ovn | AW

1
12
13
14
15
16
17
18
19
20
21

Insert Format

Data Tools Add-ons Help

Untitled spreadsheet ¢ &
File Edit View

nﬂﬁ-rl100%vsl,u‘

Sort sheet by columnC, A — Z

Sort sheet by column C, Z — A

Sort range
Create a filter

Filter views =

Slicer

Data validation
Pivot table
Randomize range
Named ranges

Protected sheets and ranges

Split text to columns
Remove duplicates

Trim whitespace

Group Option+Shift+—

Ungroup

Last edit .

b 4
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This lets you sort the data in the spreadsheet by one or more columns
along with other functions like splitting text into multiple columns.

To explain some of the options so far, | have entered some simple
checkbook data into a blank spreadsheet:

Untitled spreadsheet ¢ [

File Edit View Insert Format Data Tools Add-ons Help Last edit was seconds ag

~ o~ & P 100% - $ % .0 00 123- Defaut(r. ~ 10 - B I 5 A

A B Cc D E F

1 Check # Date Payed To Amount

2 101 8/1/2020 Electric Company 105.2

3 102 8/1/2020 Sue Smith 50

4 103 8/3/2020 Acme Grocers 153.25

5 104 8/4/2020 Gary Jones 25

6 105 8/4/2020 Gas Company 45.78

7 |

The first thing | will do is highlight the first line and format it as bold:

Untitled spreadsheet ¥+ B ©®

File Edit View Insert Format Data Tools Add-ons Help Last edit was 2 minutes ago

~ o~ & T wo%vﬂ Theme 0 + B I & A {

(2-then click here
A B Number » E F
Check # Date Pay
101 8/1/2020 Ele¢ B Bold &
3 102 8/1/2020 Sue 7 ltalic %]
‘ 103) 2020 Ay , (3) then click
5 104 8/4/2020 Gar U Underline #U h
0 105 8/4/2020 Gas ere
. S Strikethrough 38 +Shift+X
(1) click here
g Font size >
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The spreadsheet now looks like this:

Untitled spreadsheet ¢ o)
File Edit View Insert Format Data Tools Add-ons Help Last edit was seconds ag
~ ~ @& T 100% v $§ % .0 .00 123+ Default(Ar. ~ 10 - B I 5 A
A B c D E F
1 Check# Date Payed To Amount
2 101 8/1/2020 Electric Company 105.2
3 102 8/1/2020 Sue Smith 50
4 103 8/3/2020 Acme Grocers 163.25
5 104 8/4/2020 Gary Jones 25
6 105 8/4/2020 Gas Company 45.78
=

To adjust the columns to the width of the data, | can move my cursor to the
small vertical line in the header row between the columns and drag left or
right:

Untitled spreadsheet % = &
File Edit View Insert Format Data Tools Add-ons Help Last edit)

o~ = P 100% v+ § % .0 .00 123~ Default(Ar. ~ 10 i

‘ click here and drag Ieft or nght

1 Check # Date Payed To Amount

2 101 8/1/2020 Electric Company 105.2
3 102 8/1/2020 Sue Smith 50
4 103 8/3/2020 Acme Grocers 163.25
5 104 8/4/2020 Gary Jones 25
6 105 8/4/2020 Gas Company 45.78
7
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If you double click on this spot, the column adjusts automatically to the
width of the data in it.

If I do that for all four columns, the spreadsheet looks like this:

Untitled spreadsheet ¢ &)
File Edit View Insert Format Data Tools Add-ons Help Li

~ ~ & P 100% v § % .0 .00 123+ Default(Ar. v 10

¥ B C D E F

1 Check# Date Payed To Amount
2 101 8/1/2020 Electric Company  105.2
3 102 8/1/2020 Sue Smith 50
4 103 8/3/2020 Acme Grocers 153.25
5 104 8/4/2020 Gary Jones 25
6 105 8/4/2020 Gas Company 45.78
7
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| can select Column A and change it to be center aligned:

Untitled spreadsheet v &
File Edit View Insert Format Data Tools Add-ons Help

B
SRl - 1 100%l Theme

Last edit was seconds ago

11 ~ B I 5 A

102  8/1/2020 Sue Smith

101  8/1/2020 Electric Company  105.2

103  8/3/2020 Acme Grocers 153.25

50

104  8/4/2020 Gary Jones 25
105 8/4/2020 Gas Company 45.78
David Taenzer 24

Check 2
B c Number > G H
1 Check #|Date Payed To
2 101 | 8/1/2020 Electric Com B Bold B
3 102 | 8/1/2020 Sue Smith ,
4 103| 8/3/2020 Acme Groce 2 2IC *l
5 104 | 8/4/2020 Gary Jones LU Underline ¥U
6 105| 8/4/2020 Gas Compal . .
- 5 Strikethrough 3B +Shift+X
B
9 Font size > 3
10
1 ;
= Align > Left 38+ Shift+L
13 Merge cells g Center 38+ Shift+E
14 :
e Text wrapping g Right ~ S2+Shift+R
16 Text rotation >
17 Top
18 . .
B Conditional formatting Middle
20 Alternating colors ~ Bottom
21
22 . Clear formatting 3B\
23
A B C D
Check # Date Payed To Amount
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Finally, | can format column D to be currency by clicking on the column

heading:
Amount
Check # Date Payed To Amount
101 8/1/2020 Electric Company 105.2
102  8/1/2020 Sue Smith 50
103  8/3/2020 Acme Grocers 153.25
104  B8/4/2020 Gary Jones 25
105  8/4/2020 Gas Company 45.78

Untitled spreadsheet +r &

E
File Edit View Insert Format Data Tools Add-ons Help Lasteditwas3 minutes ago
-~ o~ P 100% $ Theme - B IS A & HE:E-
Amount
A 8 c Number *  ~ Automatic I
[ Check# Date Payed Plain text
I2 101 8/1/2020 Elegff€Cor B Bold B ain tex
I 102  8/1/2020 Sue Smith tali %]
b 103 8/3/2020 Acme Groce ale Number 1,000.12
I 104  8/4/2020 GaryJones U Underline H#U Percent 10.12%
o 105  8/4/2020 Gas Compal - iketh h hif
g & Stikethrough  3+Shift+X Scientific 1.01E+03
i
P Font size g Accounting $ (1,000.12)
0
1 Align N Financial (1,000.12)
2
, Merge cells I Currency $1,000.12
4 Text wrapping N Currency (rounded) $1,000
5
6 Texi rotation g Date 9/26/2008
7
8 Conditional formatting Time 3:59:00 PM
# . Date time 9/26/2008 15:59:00
0 Alternating colors
1 Duration 24:01:00
2 ¥ Clear formatting #*\
3 #,4##0 1,235
4
5 3:59 PM
6 Fri, Sep 26, 2008
7
P More Formats >
El
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Our spreadsheet now looks like this:

A B C D

1 Check # Date Payed To Amount
2 101 8/1/2020 Electric Company $105.20
3 102  8/1/2020 Sue Smith $50.00
4 103  8/3/2020 Acme Grocers $153.25
5 104  8/4/2020 Gary Jones $25.00
6 105  8/4/2020 Gas Company $45.78
7

We can sort this by Amount if we like by selecting the cells:

A B C D

1 Check # Date Payed To Amount
2 101 8/1/2020 Electric Company $105.20
3 102  8/1/2020 Sue Smith $50.00
4 103  8/3/2020 Acme Grocers $153.25
5 104  8/4/2020 Gary Jones $25.00
6 105  8/4/2020 Gas Company $45.?E.
7
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If we choose the Sort Range function on the Data menu:

Untitled spreadsheet +¢ &
File Edit View Insert Format Data Tools Add-ons Help Lasteditwa
&P 100% v 0 Sort sheet by column A, A — Z B
Check # Sort sheet by column A, Z — A
A B c G
| Check#|Date  PayedTo Am Sort range by column A, A - Z
2 101 8/1/2020 Electric Company $1(
3 102 8/1/2020 Sue Smith $¢ Sortrange by column A, Z — A
4 103  8/3/2020 Acme Grocers $1¢£
5 104  8/4/2020 Gary Jones ‘ Sort range
£ 105  8/4/2020 Gas Com $4 .
- Y Create a filter

This window pops up:

Sort range from A1to Dé

|:| Data has header row

Sortby ColumnA ~ ®A-7Z

Add another sort column
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We can click the Data has header row checkbox and change use the Sort
by menu to select the Amount column (D):

Sort range from A1to Dé

Data has header row

Sortby Amount ~ ®A-2Z

Add another sort column

Cancel

And click the green Sort button to sort the data:

A B C D

1 Check # Date Payed To Amount
2 104  8/4/2020 Gary Jones $25.00
3 105  8/4/2020 Gas Company $45.78
4 102  8/1/2020 Sue Smith $50.00
5 101 8/1/2020 Electric Company $105.20
6 103  8/3/2020 Acme Grocers $1 53.25.
-

We can sort by any column using this technique. You can also add more
columns to sort by one and then the other using the “Add another sort
column” button
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Finally, we can add a new row with the sum of all the amounts. We start by
selecting the Amount data cells by dragging from D2 to DG6:

105.2
A B c D

1 Check # Date Payed To Amount

2 101 8/1/2020 Electric Company | $105.20

3 102 8/1/2020 Sue Smith $50.00

4 103 8/3/2020 Acme Grocers $153.25

5 104 8/4/2020 Gary Jones $25.00

6 105  8/4/2020 Gas Company $45.?B.
S
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Then select Insert / Function / SUM menu item:

spreaasneet 3y Bl o

View

A

Insert Format Data Tools Add-ons Help

5 Rows above ault (A... ~

5 Rows below

Pa
D20 Ele
D20 Su
D20 Aci
D20 Ga
D20 Ga

Column left

Column right

Cells and shift down

Cells and shift right

[i] Chart
M Image (] I
™ Drawing

E Form

> Function > SUM

>4

<D Insert link HK

Checkbox

Ed Comment $€+Option+M

MAX

Note Shift+F2

MIN

New sheet Shift+F11

All

Array

AVERAGE

COUNT

Last edit was 3 minute

W ~ B I &

4
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The spreadsheet now looks like this:

=SUM( )
A B C D
1 Check # Date Payed To Amount
2 101 8/1/2020 Electric Company  $105.20
3 102  8/1/2020 Sue Smith $50.00
4 103 8/3/2020 Acme Grocers $153.25
5 104 8/4/2020 Gary Jones %25 NN
6 105  8/4/2020 Gas Company  ~o/2-23
7 =SUM(
Hit the Return key to see:
A B C D
1 Check # Date Payed To Amount
2 101 8/1/2020 Electric Company $105.20
3 102 8/1/2020 Sue Smith $50.00
4 103 8/3/2020 Acme Grocers $153.25
5 104  8/4/2020 Gary Jones $25.00
6 105  8/4/2020 Gas Company $45.78
7 $379.23
8 —
a

We can then add a TOTAL title in column C of row 8 and make it bold:
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TOTAL
A B c D
1 Check # Date Payed To Amount
2 101 8/1/2020 Electric Company $105.20
3 102 8/1/2020 Sue Smith $50.00
4 103 8/3/2020 Acme Grocers $153.25
5 104 8/4/2020 Gary Jones $25.00
6 105  8/4/2020 Gas Company $45.78
7 TOTAL | $379.23

There are many other functions available in the Insert / Function menu. All
functions start with the equals character instead of text or a number, e.g.

=SUM(D2:D6)
=SUM( ) «
A B c D
1 Check # Date Payed To Amount
2 101 8/1/2020 Electric Company $105.20
3 102  8/1/2020 Sue Smith $50.00
4 103 8/3/2020 Acme Grocers $153.25
5 104  8/4/2020 Gary Jones $25.00
6 105  8/4/2020 Gas Company $45.78
7 TOTAL $3?B.23.|

The “D2” refers to column D, row 2 and the D6 is column D row 6. The
colon character between them means all cells between D2 and D6.
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Conclusion

Google Sheets is a very good simple spreadsheet application that makes it
easy to create and update spreadsheets that you can easily access on any
computer or portable device.

There are many other features you can use but this should be enough for
you to give it a try.
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